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ABSTRACT

Callosobruchus maculatus is a major pest of stored pulses causing huge loss especially during the post-harvest 
period. Counting of obscure C. maculatus eggs performed in research studies are related to pest-control, pest-status, 
population demography, reproductive parameters, and also in sampling procedures. Counting of numerous tiny eggs 
is always performed manually which is laborious, time consuming, and tedious. Therefore, an efficient, automated 
egg counting of C. maculatus, was performed with image processing techniques using ImageJ software. Batch 
processing of 60 digital images was executed with inclusion of preprocessing, thresholding and filtering using Band-
pass, Mexican hat, and Fast filters of ImageJ software. In terms of accuracy, Band-pass method performed best with a 
mean percentage error difference of 15.55, while Mexican hat and Fast filters recorded 25.66 and 32.41, respectively. 
Pearson’s correlation was also highest (0.908) in Band-pass method. While comparing the execution time for the 
different methods, Fast Filter method showed highest percentage efficiency improvement of 65.53%. Egg counting 
time was 852 s in case of manual count but in automated count with Band-pass, Mexican hat, and Fast Filters, it was 
41, 32, and 13 s, respectively. Laborious manual counting of C. maculatus eggs in future can be replaced by this 
automated procedure with good accuracy and rapid execution time.

1. INTRODUCTION

Pulses which are a rich source of protein are under much threat 
due to the infestation of pests, especially the Callosobruchus sps. 
Callosobruchus maculatus or the pulse beetle is a common pest 
which infests Vigna radiata or green gram pulse seeds in the fields but 
display an exponential growth, once moved to storage. The huge loss 
which they cause during post-harvest is substantially brought under 
control by the use of chemical pesticides which unfortunately pose a 
serious risk to the health of the user and consumer. An effective and 
safer alternative measure of control would be ideal and necessary.

Extensive research using various botanical products, radiations, and 
pheromones is performed on insects by researchers to determine their 
ovipositional inhibitory effects and these studies involve counting 
of eggs in the pre- and post-treatments [1-3]. Other research works 
involving egg counting of C. maculatus include factors affecting 
fecundity [4,5] and comparative study of ovipositional behavior 
between two species [6].
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Counting minute and numerous eggs manually during research is a 
tedious repetitive task which is time consuming and error-prone [7]. 
Eggs are always counted using the naked eye and sometimes with the 
aid of a magnifying lens. This standard method of manual count is 
error prone, time consuming, strains the eye, and limits the feasibility 
of large-scale experiments. The integration of computers and digital 
photography which are now used in many aspects of biology can 
certainly mitigate the problems during egg counting. Image processing 
techniques have wide range of applications in various fields and 
recently at a rapid rate in the field of biology. Fields of application 
include automated counts of bacterial colonies, cell counting, egg 
counting of amphibians and insects, larva counting, fisher ling 
counting, pollen grains, and other varied applications  [8-12] from 
digital images.

Automated counts are much faster and accurate and reduces physical 
strain. In the present study, egg counting of C. maculatus is automated 
using the algorithms implemented in ImageJ, to develop a better, 
faster, efficient, and easy counting of eggs. Batch processing macros 
were developed for rapid counting of eggs from numerous images. 
There does not seem to be any previous work related to automated egg 
count of C. maculatus using image processing techniques. ImageJ is an 
open source image-processing program from the National Institutes of 
Health [13] and it is a valuable tool in research involving the analysis 
of digital images.
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2. MATERIALS AND METHODS

Green gram (V. radiata) bought from the local market were analyzed 
for the presence of C. maculatus eggs on them. The egg laden seeds 
were separated manually and on hatching, the emerging adults were 
identified as C. maculatus using their unique features such as the 
large acute spine in the hind femur and subserrate antennae. The stock 
culture consisting of 1 kg of V. radiata seeds and the adult C. maculatus 
beetles were maintained at a room temperature of 28° ± 4°C until two 
generations of C. maculatus emerged. The egg-laden pulse seeds (4–
15 days old) involved in ovipositional deterrence research work was 
used for image acquisition and egg counting.

2.1. Image Acquisition
The digital images of the pulses with opaque white eggs were captured 
using the microscope (Digital USB microscopic camera), by placing pulse 
seeds within a cavity of thin sponge that is wedged between two plain 
rectangular pieces of glasses. Elastic bands were used to bind both the 
glasses together and to keep the pulses secure, without any movements.

Twenty pulse seeds, mean length ± SD (mm) = 4.53 ± 0.46, were 
randomly taken from the stock culture and for each set of 20 pulses, 
digital images of both sides were taken by turning over the setup so 
as to increase the accuracy. Sixty digital images were created from 
random set of samples (n = 30) with 20 pulses each, taking into account 
both sides of a sample. A graph paper was stuck on the base stand of 
the microscopic camera so as to facilitate the setting up of the scale in 
the ImageJ program with proper resolution. ImageJ (v.1.51k) software 
program is used for automatic egg counting from the acquired digital 
images. Manual counting was performed by counting the eggs of the 
captured images with the naked eye.

2.2. Image Processing in ImageJ
Egg counting from the digital images using ImageJ (v.1.51k) was 
automated by executing three macros created with a sequence of image 
processing techniques [Figure 1]. In each of the macros, initially, the 
image is converted to 8 bit grey scale image (Image→8 bit). Pre-
processing of images was done through selecting proper filters that 
would best facilitate subsequent thresholding measures. In the first 
macro, the image was pre-processed through the Band-pass filter 
(Image→Process→FFT→Band-pass filter) which has the ability 
to remove both high and low spatial frequencies in an image. The 
attributes in the Band-pass filter were set to filter large = 10, filter 
small = 3, suppression stripes are set to “none,” tolerance of direction 
is set at 5% and autoscale set to “saturate.” The threshold function 
was then used to binarize the image (Image→Adjust→Threshold), 
where the Renny Entropy threshold was selected and set threshold 
(235, 255) was specified after many trials to find the best fit. The final 
step is the counting of the eggs using the analyze particles function 
(Analyze→AnalyzeParticles) with size = 27−150, circularity = 
0.70−1.00 and show = BareOutlines. The size and circularity were 
specified after adjustments to find the correct range in size.

In the second macro, after converting the image to 8 bit, the image was 
processed through Mexican Hat Filter (Plugins→Filters→Mexican 
hat filter), where the radius was set to 3 and then in the Threshold 
function setAutoThreshold = 0 and DefaultDark = 0 was selected. The 
Auto Threshold plugin ensures reproducibility and the deletion of user 
inconsistencies by the manual manipulation of thresholds.

The eggs were counted using the Analyzing Particles function with same 
settings as in the previous macro. In the case of Fast filter processing and 

counting, after the image is converted to 8 bit, the image is processed 
using the Fast filter (Plugins→Filters→Fast filter), where the link filter is 
set to minimum, x = 4, y = 4, preprocessing = smooth, and subtract offset 
= 20. The setAutoThreshold was set to be “Default Dark,” and then, the 
eggs were counted using Analyze Particles of same specifications. All 
of these processes are assembled as scripts in the macros for automatic 
analysis and batch processing. The macros were executed using the steps 
(Process→Batch→Macro) which save all the output files of the image, 
containing the egg bare outlines and the summary of each image with the 
count of the eggs. The manual count involved counting the eggs visually 
with the naked eye. The time taken for manual and automated counts of 
each method was also noted.

Mean percentage error difference was used to evaluate the accuracy 
of the automated counting in comparison with the manual counting 
method. Percentage error difference was calculated as (Automated 
egg count–Manual egg count)/Manual egg count *100. Efficiency 
improvement (Manual egg count/Automated egg count) provides the 
efficiency of automated count over manual count in terms of execution 
time of the process.

3. RESULTS AND DISCUSSION

As shown in Table  1, the Pearson’s correlation coefficient for the 
automated and manual egg count using the Band-pass filter method 

Figure 1: The overall flow chart of automatic egg count.
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was 0.908 and the Cronbach’s alpha of consistency was 0.951. The 
Pearson’s correlation coefficient for the automated and manual egg 
count using the Mexican hat filter method was 0.763 and the Cronbach’s 
alpha measure of consistency was 0.863. The Pearson’s correlation 
coefficient for the automated and manual egg count using the Fast 
filter method was 0.368 and Cronbach’s alpha measure of consistency 
was 0.538. Hence, there is significant correlation with manual count 
and automated counts of the first two filter methods, but “P” value for 
Fast filter with 0.045 indicates that the difference between both types 
of counts can be accepted and considered not significant. The scatter 
plot between the automated count with Band-pass [Figure  2a] and 
Mexican hat [Figure 2b] filters and manual egg counting shows high 
and moderate agreement with R[2] value of 0.82 and 0.58, respectively, 
while the scatter plot against Fast filter [Figure 2c] automated count 
and manual count illustrate very low agreement (0.14) between both 
methods.

The percentage error difference between the manual count and the 
three methods of automated count shows high agreements between 
egg counting of Band-pass filter method and manual count as 
represented by the shorter box plot, as shown in Figure 3a. The line 
near the middle of box refers to the median and the top and bottom 
borders of the box are the 75th and 25th percentiles, respectively. The 

box plot of Mexican hat filter has much higher range of percentage 
error difference when compared with box plot of Band-pass 
filter. Fast filter box plot shows most widespread values and poor 
performance. Outliers are noted for both Mexican hat and Band-
pass box plot. The bar graph [Figure 3b] illustrates the execution 
time of egg counting by the three filters in comparison with manual 
count.

Band-pass and Mexican filters of ImageJ program exhibited good 
results, showing similar level of performance with 12.07 and 
12.63 mean egg count, respectively, when compared with manual 
count (11.03), while Fast filter mean egg count was 9.60 [Table 2]. 
Evaluation of time taken for execution gave an opposite result, where 
Fast filter’s execution time was much less (13 s) when compared 
with Band-pass filter (41 s) and Mexican hat filter (32 s). Efficiency 
improvement values (Manual count time/automated count time) 
for Band-pass, Mexican hat, and Fast filter were 20.78, 26.62, and 
65.53, respectively. Fast filter recorded highest efficiency in terms 
of the time taken for execution. However, in spite of comparatively, 
lower efficiency in execution time Band-pass filter method provided 
best accuracy with lowest mean percentage error difference (15.55 
± 2.27) and high correlation values [Table  1]. Mexican hat filter 
method was moderate in its accuracy with a mean percentage error 

Table 1: Statistical analysis results showing the levels of correlation between the three automated egg counts and manual count and the mean percentage error difference.

Paired samples correlations

Egg count pairs Mean percentage error difference±SE Pearson’s Critical P value R2 Cronbach’s alpha

Band‑pass filter 15.55±2.27 0.908 0.000 0.82 0.951

Mexican hat filter 25.66±3.71 0.763 0.000 0.58 0.863

Fast filter 32.41±6.06 0.368 0.045 0.14 0.538
For Pearson’s correlation at 0.05 level there is significant difference between the manual and all three methods of automated counts

Figure 2: Graphic representation of the agreement of ImageJ automated counts with manual count of eggs. Scatter plot of manual count against the ImageJ Band-Pass 
filter automated egg count showing good agreement (R2 = 0.82), (b) scatter plot of manual count against the ImageJ Mexican hat filter automated egg count showing 

medium agreement (R2 = 0.58), and (c) scatter plot of manual count against the ImageJ Fast filter automated egg count showing very poor agreement (R2 = 0.14).

cba

Figure 3: (a) Box plot showing the percentage error difference of the three filters with the manual count. Band pass filter of ImageJ performs best with least error 
difference and (b) bar graph showing the comparison of execution time in seconds by the various ImageJ filter methods and manual count.
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difference of 25.66 ± 3.71, while Fast filter recorded a value of 
32.41 ± 6.06.

When manual and automated egg counts were compared that 
they seem to provide similar results except in Fast filter method 
showing deviation from the manual count. The mean percentage 
error difference for Band-pass filter was 15.55 ± 2.27, R[2] value 
was 0.82 and Pearson’s correlation coefficient value was 0.908. On 
the other hand, there was a drastic difference in the execution time 
with automated counting of Fast filter, performing far too well. The 
execution time recorded for Fast filter method was 13s, while for 
Band-pass filter, it was 41 seconds. This study proves that automatic 
counting of C. maculatus eggs using ImageJ filters to be a quick, 
accurate, and non-destructive.

The Band-pass filter removes noise but preserves the larger aspects in 
the digital image [14], while Mexican hat filter separates signal from 
the noises using Laplacian or Gaussian filter. Manual and automated 
count have their own advantages and disadvantages. Magnified digital 
images provide a clearer sphere of egg detection, but the disadvantage 
to be taken into account are the unexposed eggs that might be found on 
the sides of pulses. Hand held manual counting involve direct counting 
with the naked eye or a magnifying lens which certainly is tedious, 
error prone, and time consuming.

An ideal condition for an automated count needs high contrast between 
the egg and the background and a low glare from the surface [15]. 
The challenges in this study of is the presence of white hilum on 
green gram seeds which are very similar to the eggs of C. maculatus. 
Furthermore, certain peak areas with highest reflection points on 
green gram may interfere, to give false results. Both these problems 
were eliminated using thresholding and circularity measure. The 
“threshold” command in ImageJ initially separates background from 
the particles of interest  [16] automatically, and here, it separates the 
background from the white eggs, hilum region, and the glare points. 
The glare points and hilum are then distinguished from the egg by 
precise specification of the “circularity” measure. Since hilum has a 
greater circularity, than the egg their inclusion was eliminated from the 
count by specifying proper circularity (0.70–1.00).

Manual method is extremely time consuming and quite impossible 
to be implemented in large-scale analyses, but still it is in usage due 
to its quality results and simple procedure [17]. The present study is 
promising by providing results with good accuracy in par with manual 
count. The correlation values and R[2] values have shown the extent of 
good correlation between automated and manual count.

With regard to automatic egg counting, Band-pass and Mexican hat 
filters are superior to Fast filter of ImageJ. Furthermore, using macros 
and batch processing plugins of ImageJ program produced results at 
a very rapid rate which can never be achieved by manual or hand-
held egg count. In summary, the Band-pass filter coupled with Renyi 

Entropy threshold and the other processes of ImageJ employed in 
this work have shown to be a good tool in automatic counting of 
C. maculatus eggs from digital images. In future, this work can be 
extended in counting insects, their eggs and also in distinguishing the 
eggs of early stages from eggs of later stages to assess their life cycle 
during infestation.

4. CONCLUSION

ImageJ software with its functionalities and filters aids well in counting 
the eggs of C. maculatus laid on V. radiata. Among the three filters of 
ImageJ software studied, Band-pass filter showed best performance 
with least error (15.55 ± 2.27). The time consuming and tedious job 
of manual egg counting is overcome by the batch processing of digital 
images which drastically reduce the time taken to count the eggs with 
high efficiency improvement (65.53). In future, the digital image 
processing techniques in ImageJ software would certainly prove to be 
efficient, especially the Band-pass filter with Renyi Entropy threshold, 
in counting the eggs of C. maculatus.
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